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Analytics 

Overview 

Analytics are calculated from live values of the process and can optionally be recorded to a database 

so that a history of their values is available for reporting purposes. 

 

Except for Snapshot analytics that only require the Store action, analytics are produced in two steps 

using an Update and Store action.  The first step is to update the value of the analytic periodically and 

the second step is to store the analytic so that its values are available for use. 

 

Example: To calculate the hourly maximum and minimum of the mixer speed from one minute process 

values the following steps are required. 

• Step 1: Set the Update (see later) of a Statistic analytic to one minute to read the process 

value and update the summary values.  Note that the process values themselves are not stored 

(except for the Snapshot analytic).   

 

• Step 2: Set the Store (see later) of the Statistic analytic to one hour to stop the calculation of 

the analytic, store it for reporting purposes and start a new calculation.  

 

After a Store, the current values of the analytic are available for use using Variables. 

 

If a history of the analytics is required, an Analytic Connector must first be created.  From the Data 

tab of the Project Explorer, select Connectors. 

 

• Choose XLReporter, Analytic values 

• Click OK to open the connector configuration. 

• Select the [.] button next to the Primary Database Type, this will open the Database 

Connect window. 
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If possible, use a Microsoft SQL Server (including Express) database. Alternatively, a Microsoft 

Access database is included in the Data folder of your project which can be used to store analytic 

values. Click Test Connection to verify database connectivity. 

 
On the OK of the data connector configuration, the analaytic tables will be created in the database.  

Analytic Designer 

The Analytic Designer is used to configure Analytics and optionally set them up to save their values 

to a database.  The designer is opened from the Data tab of the Project Explorer by selecting 

Analytics. 

 

 
 

The display consists of the two tabs Data Items and Schedule.   

 

To save changes click File, Save.  If the Scheduler is running, it is automatically reloaded with any 

changes.   
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The Storage option is only enabled if an Analytic connector has been defined.  

 

 

 

The Backup Path is used to cache analytic history in the event of communication failure.  When 

communication is re-established, the cache is forwarded to the database of the Connector.   

Data Items 

 
 

The left view of the Analytic Designer displays the analytic categories.  Select a category to display 

the configured analytics in the grid.   

 

• Group is the group number for the analytic.  This number can be used to manage analytics so 

that they can be updated and/or stored at the same time or on the same event.  For example, if 

the average of the Mixer temperature is required every hour but the maximum Mixer pressure 

is required every day, the analytic for the Mixer temperature would be configured for Group 

1 while the Mixer pressure would be configured for Group 2. 

 

By default, the group number 0 has a “global” group meaning in that any update or store on 

any other analytic will affect them.  

 

• Name is the name of the analytic.  This name will be displayed when browsing for analytic 

values during the setup of a template. 

 

• Description is a description of the variable.  This description will appear in the analytic 

browser. 

 

• Connector and Source collectively define the process value used to calculate the analytic. 

 

To add/modify an item, select a row and double-click, click the Modify menu option or select Modify 

from a right click. 

 

To remove an item, select a row and press the Delete key, click the Remove button, or select Remove 

from a right click. 
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Snapshot 

A Snapshot stores the current value of numeric values from the process. 

 

 
 

The Snapshot is saved with a timestamp and current value of the process using the Store action. 

 

The analytic supports compression limits which will reduce the quantity of data stored: 

• Value Limits 

If enabled, the value must be within the limits specified (inclusive) for it to be stored. 

• Value Deadband 

If enabled, the value must change from the previous value by the deadband (specified in 

engineering units) for it to be stored. 

• Time Deadband 

If enabled, the value is stored if the period has elapsed since the time of the last store. 

 

The Snapshot analytic provides the following Fields: 

• :Stdt (data and time) 

• :Cval (current value) 

• :Qlty (value quality) 

o 0 = Bad quality (according to the data server) 

o 1 = Good quality 

o 2 = Suspect quality (according to the data server) 

o 4 = No value 

o 8 = Bad server (e.g., could not connect to server) 

 

Profile 

A Profile analytic calculates metrics from discrete process values, such as on /off counts and on/off 

durations.  The process value is regarded as being in the “off state” if its value is between +/-0.5 

otherwise it is in the “on state”. 
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A Profile is updated on an Update and is available for reporting on a Store. 

 

The Profile analytic provides the following Fields: 

• :Stdt (start date and time) 

• :Endt (end date and time) 

• :Durn (difference between the start and end in days) 

• :Onct (on count) 

• :Onse (on duration in secs) 

• :Ondy (on duration in days) 

• :Onpt (on duration as a percent) 

• :Ofct (off count) 

• :Ofse (off duration in secs) 

• :Ofdy (off duration in days) 

• :Ofpt (off duration as a percent) 

• :Gcnt (count of good samples) 

• :Bcnt (count of bad samples) 

 

State Profile 

A State Profile calculates metrics on how long and how often process values have occurred within 

specified by data ranges. 

 
 

A State Profile is updated on an Update and is available for reporting on a Store. 

 

Up to four State ranges can be configured.   The Source is compared to each state and, if the value is 

in the data range, the count and duration of that state is updated.  If States are Sequential is checked 

then the calculation is performed in a state until the Source value takes it to the next state. 

 

The State Profile analytic provides the following Fields: 
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• :Stdt (start date and time) 

• :Endt (end date and time) 

• :Durn (difference between the start and end in days) 

• :Cnt(1 to 4) (state count) 

• :Dns(1 to 4) (state duration in secs) 

• :Dnd(1 to 4) (state duration in days) 

• :Lov(1 to 4) (state low value)  

• :Hiv(1 to 4) (state high value) 

• :Gcnt (count of good samples) 

• :Bcnt (count of bad samples) 

 

Difference 

A Difference calculates metrics on the difference of an analog value taken at different times.  An 

example would be to calculate the total from a totalizer. 

 
 

A Difference is updated on an Update (which updates the start timestamp) and is made available for 

reporting on a Store (which updates the end timestamp). 

 

The signal Type is either increment (the Source increments such as a flow totalizer) or decrement (the 

Source decrements such as a weigh scale).  If the Source rolls over at a certain value then this is 

accounted for by specifying the Rollover (0 means no rollover).  The Scale value is constant used as a 

scaling factor of the result. 

 

The Difference analytic provides the following Fields: 

• :Stdt (start date and time) 

• :Endt (end date and time) 

• :Durn (difference between the start and end in days) 

• :Dfsd (date and time of start sample) 

• :Dfsv (value of start sample) 

• :Dfed (date and time of end sample) 

• :Dfev (value of end value) 

• :Dfcv (difference between the start value and end value) 

• :Dfsc (difference between the start time and end time in secs) 

• :Dfdy (difference between the start time and end time in days) 

• :Type (difference type) 

• :Roll (rollover value)   

• :Conv (scaling factor) 

• :Gcnt (count of good samples) 
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• :Bcnt (count of bad samples) 
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Statistic 

A Statistic calculates statistical summaries for a process value.  The values used in the calculation can 

be filtered by value limits. 

 
 

A Statistic is updated on an Update and is available for reporting on a Store. 

 

The Source value is not considered unless it satisfies the compression limits: 

• Value Limits 

If enabled, the value must be within the limits specified. 

 

The variable provides the following Fields: 

• :Stdt (start date and time) 

• :Endt (end date and time) 

• :Durn (difference between the start and end in days) 

• :Totl (total) 

• :Maxm (maximum) 

• :Mxdt (time of maximum) 

• :Minm (minimum) 

• :Mndt (time of minimum) 

• :Rnge (range) 

• :Avge (average) 

• :Devn (deviation) 

• :Gcnt (count of good samples) 

• :Bcnt (count of bad samples) 
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Schedule 

The Schedule tab determines when Analytics are Updated and Stored.   

 

 
 

To add a schedule click Add. 

 
In the upper part of the display define the Condition on which to trigger the action.  In the lower part 

of the display, specify the Action to perform when the Condition is met.  

Actions 

Reset Group, Reset All 

These Actions reset the analytic value(s).  Typically, this is not required as the reset automatically 

happens on a Store. 

Update Group, Update All 

These Actions update the value of the analytic value(s) using the process value assigned to the 

analytic.  This is supported for every analytic except Snapshot. 

Store Group, Store All 

These Actions store the value of the analytic value(s) so that they can be used in a report.  If historical 

Storage is enabled, they are also saved to a database. 
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Purge 

These Actions purge old records from the historical database that are older than Older (days). 

 

Example: Using a Statistic analytic variable (seen in Data Items, Statistic), calculate the hourly 

maximum and minimum of the mixer speed from one minute process values. 

 

To achieve this, an Update action is run every 1 minute to collect sample values. A Store action is run 

every 1 hour for the resulting metric values to be available for reporting. 

 

 
 

When two conditions happen at the same time, for instance every hour in the example above, they are 

processed sequentally top to bottom. 

Schedule Delay 

When analytics are Stored on time or on an event, it is usual for a report to be produced on the same 

condition. To make sure the Store of the analytic has completed before the report is produced, a Delay 

Execution can be specified in the Update Worksheet or Update Workbook action.  

 

For example, consider the analytic schedule configuration below that represents a Snapshot being 

Stored when a cycle completes: 

 
The corresponding schedule action to produce the report would be configured as follows: 

 
Note that the Condition is the same as the analytic Store condition. However, a 30 second Delay 

Execution setting is used to cause the scheduler to wait 30 seconds after the cycle finishes before it 

produces the report. 
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Reporting from Analytics 

Overview 

There are two options available to report from analytics, either real time or historically (if analytics are 

configured to store to a database). 

Real Time Analytics 

The real-time values of analytics are the last Stored values and are accessed by Variables. The syntax 

of a variable is {Name:Field} where Name is the name of the analytic and Field depends on the 

analytic category (see above). 

 

For example, the maximum value of a Statistic analytic called Mixer would be referenced by 

{Mixer:Maxm}. 

 

Common usage of Analytic variables is in a Report Template or as parameters in data groups. 

 

In a Report Template, select the cell that will receive the value and click the Connect button on the 

ribbon to open Data Connections.  

 

In Data Connections,  

• set the Connector dropdown list to Variables. 

• select the […] button next to the Name field, this will list the available variables configured 

within the project.  
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When an analytic is selected, the Fields for that analytic are displayed at the bottom. 

Historical Analytics 

Analytics can be configured to Store to a database and retrieved using an Analytic Group in the 

report template. 

 

Analytic Group 

The Analytic Group is similar to the History Group and so detailed information can be found in the 

History Group documentation. 

 

To report on data from historical analytics, an analytic group must be configured.  One way to do this 

is directly from the project explorer using Tools, Connector Groups or from within a template using 

Data Connections. 

 

 
 

The following group types are available: 

Summary Values 

This group type retrieves values in the database and provides additional summary calculations. 

 

By default, the summary values are time-weighted and values are propagated based on the last 

known value.  To change this so that summary values are calculated strictly on the data returned, 

check use raw values. 

 

Raw Analytic Values 

This group retrieves the values in the database. 

 

Custom Values 

This option opens the Database Group builder where a query can be configured to retrieve data 

from any table in the database.  
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Group Settings 

Setup Tab 

 
 

Analytics 

This section defines which Analytic Type is used for the selected Columns.   

 

Retrieval (Summary Values Group) 

The Retrieval settings define how much data is retrieved for the calculations selected for 

the summary calculation.  The following settings are available: 

• Retrieval Mode 

This setting defines how data is retrieved from the historian.  For Analytics, only 

Raw Values is available. 

• Lead Time 

The amount of time (in seconds) to retrieve data before the start time of the 

group (see Time Period tab). 

 

Columns Tab 

 
 

The Columns tab defines which analytics are used by the group. 

 

To add an item, select a cell in the Name column, and click the browse button (…) to open 

the item browser. 
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In the top left, a Name is selected which can be one of three choices: 

• Literal 

A Literal is the given Name of the item (as configured in the Analytic Designer). 

• Variable  

A Variable (displayed in {}) provides a way to assign the item names externally, 

e.g., when the group is used on-demand, the item name is selected. Variable names 

can be selected from the Variables branch of the item browser and can be a User-

Defined or a Register variable. User defined variables are not limited to the {Tag X} 

syntax – these can be assigned to any expression, e.g. {Temperature} or {Pressure} 

by typing in the name. 

• Static  

A Static (displayed in *{}) is considered fixed text for display only and is not used 

for data retrieval. In the item browser, select Treat As Text to configure. 

 

Grid rows are moved relative to each other, Inserted or Deleted by right clicking on the left 

most column or using the up/down and insert/delete keys on the keyboard. 

 

When empty rows are set between two items, the output of the group will contain empty 

rows/columns.  Use empty rows to prevent calculations in the template from being 

overwritten by the output of the group. 

 

Please refer to the History Data Group documentation for more information on the 

remaining settings. 
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Web Portal 

The web portal is provided with the Distributed edition of the product. It gives access to produce 

reports on-demand, complete forms and view scheduled reports from windows and web clients across 

the network.  

 

If a template is used from a client that requires process tag names, a Connector Catalog is required to 

provide the tag information. 

 

To create a catalog, navigate to the Data tab and open Connectors. In Connectors, select the Analytic 

Database connector and then select Catalog. 

 

In the Catalog Builder, select Add Catalog. Give the new catalog a name and select the analytic type 

from the dropdown list on the right. 

 
Click the […] button in the Item column to open the Tag Browser. Select the analytic items and fields 

required for this catalog. Click OK when finished to save. 
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Information in this document is subject to change without notice.  SmartSights, LLC assumes no 

responsibility for any errors or omissions that may be in this document.  No part of this document may be 

reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without 

the prior written permission of SmartSights, LLC. 
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XLReporter® is a registered trademark of SmartSights, LLC. 
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